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Overview

Dictionary and Encyclopedia Personal Reader (DEPReader) is dictionary
software program for PDAs, included as a bonus part in the distribution package of
different dictionary and reference databases. DEPReader is not a dictionary or
encyclopedia itself, you need a database to run the application.

Supporting multiple dictionary databases in an exclusively compressed format, it
allows you to carry your favorite dictionaries on PDA everywhere.

In addition to the standard lookup function, DEPReader supports other search
modes - phonetic, wildcard, error tolerance - to help you find a word or compound
even when you do not know the exact spelling. One-tap lookup of words found in the
dictionary definitions is provided.

DEPReader allows you to view the cross references available in the dictionary
entries. When using a Bible dictionary and a Bible translation compatible with other
GMPSoft’s products, DEPReader allows immediate Bible verse look-up of the verse
cross references via pop-up function.

DEPReader may be personalized by customizing its layout, it allows the addition of
personal user notes and bookmarks to the dictionary entries.

Purchase DEPReader Compatible Dictionaries and
Reference Resources

Purchase from: http://www.palmgear.com

> Find the GMPSoft product (Dictionary or Reference
resource) you desire
» Click on BUY and follow the instructions

Warning: The screenshots herein have been taken from 7he Concise Oxford
English Dictionary, The Pocket Oxford English Dictionary and The Oxford
Dictionary of the Bible (°Oxford University Press). Note that if you use other
dictionaries the results may differ.
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1 Start the application

Locate the Dictionary and Encyclopedia Personal Reader (DEPReader) icon
on the Applications screen of your Palm OS handheld. Launch the application by
tapping on the icon.
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2 Registration

2.1 Licenses

To use DEPReader, you need a user license for a dictionary/reference database:

1. Trial License — Includes all the functionality of the Standard License

plus indication that the product needs to be registered.

2. Standard License — Indicates that you have successfully licensed a

DEPReader compatible product.

2.2 Product Registration

Register the product without manual unlock code input. Just install your PADUnlock

file (PAIm Database Unlock System) on your Palm OS device.

PADUnNlock is a database file (.pdb type), containing your registration information
for each one of the products you have purchased. You receive your PADUnNlock file
after you order a License for a GMPSoft product and register it in our system

database.

1. Get your PADUnlock:
» Follow the Unlock Key link in the Sales Confirmation
email you have received after the purchase.
» Click on GET IT link in your Product Info page.
» Save the file on your PC

2. Install PADUnlock
» Install the PADUnlock database in the RAM of your
device or on the expansion card.

3. Go to the Registration form:
» Launch DEPReader
> Tap on the Headline bar or the Menu button to display
the form menu
> Tap on Book
» Tap on Registration

> Draw the Graffiti Menu Command stroke » and the letter
R on the silkscreen
Or
» Tap on the Register button in the trial reminder form

(I3 Edit View
Registration..

7R |m from

f| Dictionary.. 7D
i Bible... 7B
E About Books 7T
E_Fllmut U

Ehood(2) n./
Ehood(3) n./
B'll; contr./t
E'm(1) abk-«
E'm(2) n/¥
B'n'; contrwi
O

W




4. Apply your PADUnlock registration information:

> Tap on the Scan button Trial

Oxford Bible Dictionary

. . . Concise Oxford English Dict
GMPSoft products support PADUnlock file registration Easton

protocol and use it to automatically register your products. Pocket Oxford English Dict
Webster's American Family Diq
Note: The 7rial reminder form will still appear if there is even Webster 1913

one product with a Trial License state.




3 Customize DEPReader

Dictionary and Encyclopedia Personal Reader allows you to activate and search
in the database of the installed dictionary and even search for entries in several
dictionaries at the same time. You can select the text size that will be best for you
and also apply bold formatting for better visibility.

. . - [DEPR | ik
3.1 Selecting a dictionary ~ « [Select item from

B cause; conj list to view

: icl
1. Open the Select Books form L

> Tap on the Headline bar or the Menu button to display E'gainsct;)prm
hood(1) n.A

the Book menu Bhood(2) n7
Ehood(3) n./
B'll; contr.£
BE'm(1) abkc
BE'm(2) n/¥
&'n'; contr'wi
T

> Tap on Dictionary...

Or

» Draw the Graffiti Menu Command stroke » and the letter

D on the silkscreen Edit_View

Registration.. /R |mfrom
W

f[ Dictionary.. 7D

§|Bible... 7B

E About Books /T
About U

§ m——

Ehood(2) n./

Ehood(3) n./

E'll; contr./t

BE'm(1) abk«

E'm(2) n/¥

B'n'; contr®i

R —

2. Scan for new Dictionaries

> Tap on Scan

Dictionaries

Dictionary and Encyclopedia Personal Reader stores 'E(:s\fc,,,

cached information about the installed dictionary databases. [/ Webster 1913

. ’ L Yens -
This speeds the operation when you use memory cards. Sl O e D

It is not necessary to scan each time. Scan when you:
e Install new Dictionary(ies)
e Delete Dictionary(ies)
e Transfer Dictionary(ies) from the handheld RAM to ((Close ) (Scan ] ((Done )
the memory card or vice versa

e Move Dictionary(ies) in another folder of the memory
card

3. Choose one or more Dictionaries
> Enable the checkboxes of the respective Dictionaries



The abbreviation of the selected dictionary will be displayed
at the Headline bar.

4, Confirm
> Tap on the Done button

3.2 Adjusting the Preferences

Dictionary and Encyclopedia Personal Reader allows you to adjust the way the
information will be displayed.

1. Choose Preferences from the Edit menu

> Tap on the Headline bar or use the Menu button to
display the form menu

> Tap on the Edit menu

> Tap on Preferences

Or

> Draw the Graffiti Menu Command stroke » and the
letter P on the silkscreen

2. Text size — you can choose Smaller size to have
more text displayed at a time or Larger for better

VISIbIlIty Text size: ¥ Medium
» Tap on the down arrow next to the Text size field O Apply bold formatting
» Choose a text size from the drop down list [ Apply colors

3. Apply bold formatting to text — enabling of this
option is recommended for people with poor
eyesight or in case the light is not sufficient

> Enable Apply Bold Formatting check box

Warning: As some entries use plain and bold formatting to
differentiate certain adjoining fields, applying this option will
obliterate this differentiation.

4. Apply colors — disabling this option will turn off the colors used in entries for

some Dictionaries.
> Disable Apply colors check box



3.3 Customize the Screen Layout

Dictionary and Encyclopedia Personal Reader allows fully adjustable vertical
and horizontal screen split between the Word List window (1) and the Entry window
(2) and easy switching between different layouts.

1. Default layout IRy = coe dbFHIY
The default layout of Dictionary and Encyclopedia researc ¥ « |research 2

ﬂreseah‘; 3 Jrus3f, ritss:
Personal Reader B market rese(m n. the systematic

B operational |jnvestigation into

(1) The Word List window contains the Lookup field (3) and =:§§§:i‘f}“ and st_u;iy ofd
= * Y|materials an

the three Specific Search Tabs (4). =::::th /1l sources in order to
Ireselec't;js_t establish facts and

(2) The Entry window displays the word found and its BEresell; v./& Feacfi new

L . . _ @ resemblarwe| conelusions. = v.
dictionary entry which may contain the pronunciation, B resembletw|cargy out research
definitions, subject labels, notes on grammar, morphology __h___=Flinto. = use

and spelling, word origin and usage etc.

Layout Selector at the right upper corner of the display allows you to specify

the layout of the application. The Left icon shows Current Layout and the Down E:I -
arrow button is for showing the Layout History.

2. Display the most recent used Layouts IR = cor TE~
¥ « [research 1
Layout Selector keeps history of the most recent used |;srr_;asr:arCh; T ——

Layouts Emarket resem n. the systemaric

B operational |investigation into
Eresearch ani

> Tap on the History Layout button E:I ¥ (the down Breseat: v 3| 0 Study of

. d : materials and
arrow) to display the list of most recent used layouts Bresect; v./1| 0 rees in order to

BEreseed; v./° -
B reselect: L establish facts and

BEresell; v./ & reach new

B resemblarwe| coneclusions. = v.
& resemblewy| carry out research
into. = use

3. Display the list of all supported standard Layouts

[DEPR L]€e3) 4P E]~
> Tap on the History Layout button E:I b (the down respect ¥ = [respects n. £1F

arrow) to display list of most recent used layouts Brespect; n.feeling of deep
Brespectable |admiration for
="ESPECT_f“|:' someone elicite 5
respecting; by their qualitie
E Erespect!ve; or achievemente=]
Brespectively| (respects) I=]

E:::Eﬁ"e;- \:,.ﬁ polite greetings =]
> Tap on the down arrow button w (Layout index Brespiratea Zhd“fe fl";g'ﬂrd fo
; Brespiratiow; |the feelings or
button) at the bottom of the Selector to display all B aiciml 7 | rights of others.

standard layouts A %713 a particular

4. Select Layout
> Tapon an icon representing a particular layout



Dictionary and Encyclopedia Personal Reader supports
4 basic layouts which you can enable by the following icons:

a. Vertical Layouts E:I, I:E, E:I, I:E

Vertical Layouts have the Word List and the Entry windows
separated by a vertical splitter line.

b. Horizontal Layouts %, %, %, %

Horizontal Layouts have the Word List and the Entry windows
separated by a horizontal splitterline.

c. Dictionary Entry Layout

Only the Entry window is displayed.

d. Word List E

Only the Word window is displayed.

@ECOED dbEFE]~

researc ¥ = [research
Bresearch; n.|/msatf, ,risssty/
B marketrese(m n. the systematic
B operational |investigation into
Bresearchan,nd study of
Breseat; v./2 o erials and
Bresect; v./1 .

sources in order to

Ereseed; v./° -
‘reselect'i- establish facts and

Bresell; v./a |reach new

B resemblarwe| conclusions. » v.
B resemblewy| carry out research
into. » use

@ECOED b~

flute = n. 1 a high-pitched i
wind instrument consisting of a
tube with holes along it, usually
held horizontally so that the
breath ean be directed against a
fixed edge. 2 Archilecture an

v

flute A
B flute; n.v./5 A
& fipple flute; n./1 -~
B nose flute; n./1 hat
P_Lmns_\u:_rse flute: n./1 hd
M, A !

@ECOED 4> [F E~

major = adj. 1 important,
serious, or significant. » greater
or more important; main.

2 Music (of a scale) having
intervals of a semitone between
the third and fourth, and
seventh and eighth degrees.
Contrasted with MINOR. = (of
an interval) equivalent to that
between the tonic and another
note of a major scale, and
greater by a semitone than the

mﬂcom drd=\d

court v -
BEcourt; n,v./7

B county court; n./1

B Crown court; n/1

B district court; n./1

B high court; n./1
Ehigher court; n./1

EInn of Court; n./1

B juvenile court; n./1

B kangaroo court; n./1
Elaw court; n./1

B lower court; n./1

, h, ,

LIy




5. Switching between the Most Recent Used Layouts

The Layout Selector saves the history of the most recently
used Layouts enabling you to change them consecutively.
To go to a desired Layout included in the list of most recent
used layouts:

> Tap on the Current Layout icon at the right upper corner

Each tap changes consequently the layout to next one in the
list of most recent used layouts.

> Repeat until the desired layout has been selected

The information kept by the Layout Selector about layouts
used is dynamic. If you stick to using only a few or even one
or two layouts for a longer time, the Layout History index
will be adjusted to show only them. This will save you time
as by tapping on Current Layouticon you will rotate only
these layouts.

Adjusting the widths of the Word List and Entry

windows

> Tap on the splitter line

> Move it in the desired direction until you reach the
preferred width

micom b~

modernism = n. modern
ideas, methods, or styles. » a
movement in the arts or religion
that aims to depart significantly
from traditional forms or ideas.
- DERIVATIVES modernist n. &

—

4

LD T [

modernism

B modernism; n./1
BEmodern; adj.,n./2
B modernize; v./1

Eouiesl

mucom {PEFEI-

investig ¥ « invel»_,tigate
Hinvestigate;[m v. eirry cut a
Binvestigativ(syste iatic or
ﬂ_private inve|formeY inquiry into
Binvest; v./4|(an irdident or
Binvestiture;| .11, 0n
5

BEinvestment;

Hinward inves estab gsh the
B outward ima truth]= carry out

Binvestmem | reseaxch into (a
Binvestmeiw |Subjegt). > make a
& franked irwe| searchk or

syste [1atic inquirv.+

ipn) so as to




4 Smart Word List

DEPReader gives instant search results in a Smart Word List for greater data

accessibility. Unlike the standard Alphabetical Word List which is used in other

dictionary software programs, Smart Word List shows not only the headwords
beginning with the search word, but also those containing it.

4.1 Smart Word List advantages:

Multiple Dictionary Lookup —allows you to search for words in several dictionary

databases at the same time

Lists not only entries beginning with the search word, but many others that may be

of interest for you

Instant positioning - the search results are displayed while you are still entering

characters

Searching for inflected forms of a word — allows you to find words by searching for

inflected forms

Better data accessibility in comparison to the standard alphabetic search result

4.2 Words Search

The Smart Word List allows finding words’ definitions not only by entering the

exact headword but also by entering inflected forms.

For example, if you enter the inflection *hiding’ in the
Lookup Field, the Smart Word List looks like this:

hiding(1)
hiding(2)
hide...

The main form of the word that is of interest to you appears
right after the exact matches.

With the Smart Word List, a single lookup gives you not
only the entries beginning with the search word, but also all
the ones containing ‘acid’ that may be of interest to you :

acid

abscisic acid
acetic acid
acetylsalicylic acid
acrylic acid

valproic acid
tricarboxylic acid cycle
acid drop etc.

gv

Select item from list to view

article

hiding

B hiding(1) n./2

B hiding(2) n./1

B hide(1) v.n./2
ide- . n./1

acid

B acid; n.,adj./7

& abscisic acid; n./1

B acetic acid; n./1

B acetylsalicylic acid; n./1
B acrylic acid; n./1

B adipic acid; n./1

2 alginic acid; n./1

B alpha-hydroxy acid; n./1
& amino acid; n./1

& arachidonic acid; n./1

B ascorbic acid; n./1
A, *,

LI44»»




Immediately after the actual search word, you have all the
acids listed, which the ordinary alphabetical list does not do.

Just for comparison, if you lookup ‘acid’ in other dictionary
software, the alphabetical word list might look like this:
acid
acidify
ack-ack
acknowledge etc.

The list above contains only the entries beginning with your
search word and next entries in dictionary alphabetical
order.

4.3 Exploring Compound Terms

When you explore the dictionary you may notice that a particular word may be found
not only as a headword but also as part of a compound term. Generally there are 5
sets of compounds that might include your entry, which the Smart Word List lists
in the following order:

(1) Exact match(es)
For example, ‘acid’, ‘air’, etc.

(2) Compounds including the search term as the last word
For example, ‘compressed air’, *hot air’, etc.

(3) Compounds with a space
For example, ‘air ball’, ‘air bearing’, etc.

(4) Compounds with a hyphen

For example, ‘air-dry’, etc.

(5) Compounds without a space
For example, ‘airbag’, ‘airbase’, etc.

In order to immediately position the Smart Word List on one of the above sets,
use the following rules:

(1) Exact match(es) [DEPR | =id

> Enter your search word in the Lookup field ?.'“air; e

B compressed air; n./1

Ehot air; n./1
B air ball; n./1
B air bearing; n./1
& air bed; n./1
B air bladder; n./1

(2) Compounds including the entry as a last word EZ!EE::?FZ r:1fj21
> Enter your search word in the Lookup field & air chie?r;,a,'shak n/

» Scroll down the Smart Word List with the help of the ;lair commofore: n/1
scroller arrows

The Smart Word List will position you on the exact match.

LId4r >

».




Because the exact matches of your entry are only a few, you
may simply scroll down the results list to view the
compounds in which your entry is the last word.

(3) Compounds with a space
> Enter your search word with a space at the end

For example, enter ‘air ' — you will immediately be positioned
on the set of compounds formed by the word ‘air’ with a
space.

(4) Compounds with a hyphen
> Enter your search word with a hyphen at the end

For example, enter ‘air-' — you will immediately be positioned
on the set of compounds formed by the word ‘air’ with a
hyphen.

(5) Compounds without a space
> Enter your search word and the letter ‘a’ at the end

For example, enter ‘aira’ — you will immediately be positioned
on the set of compounds formed by the word ‘air’ without
space.

@ECOED e~

air__ v -
B air ball; n./1

& air bearing; n./1

& air bed; n./1

& air bladder; n./1

B air brake; n./2

& air bridge; n./1

B air chief marshal; n./1
& air commodore; n./1
& air conditioning; n./1
B air corridor; n./1

& air cover; n./1

% .

LId4r

mﬂcom PrE~

air- v -
B air conditioning; n./1
B air-dry; v./1

B air-kiss; v.,n./2

B air-searescue; n./1

& air-to-air; adj./1

B air-to-ground; adj./1
B air-to-surface; adj./1
B airbag; n./1

B airbase; n./1

B airboat; n./1

& airborne; adj./2

, h,

LIy

mﬂcom PrE~

aira -
B airbag; n./1

B airbase; n./1

B airboat; n./1

B airborne; adj./2

& airbrick; n./1

B airbrush; n.,v./2

B airburst; n./1
Baircraft; n./1

B aircraft carrier; n./1
B aircraftman; n./1

& leading aircraftman; n./1
. 13

LIy

Warning: As a by-product of the speed optimization, some key words may appear

twice in the search result.




5 Searching for Terms

Dictionary and Encyclopedia Personal Reader supports several mechanisms for
searching for terms. Whether you know the word or not, if you are not sure of the
exact spelling or are uncertain of some of the letters, or even if you know only how a
word sounds, the application can assist you in finding the correct match.

5.1 Standard Search

1. Enter your word in the Lookup field R oo

JPFE -
> Use the Silkscreen Graffiti area or the system keyboard EQ

flute  w = |flute .n. 1a
BEflute; n.v./|high-pitched wind

The Word List window will display the words beginning with Eut‘e; fnl_,tv_( ingtrument

the characters you've entered while you are still entering ripple flte; consi f,,ti't?lghooflzs

e Hatns.vers_ef along it. 2 a tall,
zFIitiz : ‘t" ™ narrow wine glass.

2. Display dictionary entry Bt A ook i e

; Aflute a bom fluted) speak in a
> Tap on the exact word or on a word that is closest to the Bfluted: s tuneful way.

one you are searching for in the List window Siyrediini® }IZ;IE;“;O“ French ¢

3. Scroll the Word list up/down
> Use the smaller arrows at the right of the Word List
window to move the list up/down by one line

> Use the bigger arrows at the right of the Word List
window to move the list up/down by one page

5.2 One-tap lookup of words found in the dictionary definitions

DEPReader allows you to look up words not only by entering them in the Lookup
field, but also by tapping on the words in the dictionary definitions.

1. Lookup a word from a dictionary definition
» Tap on the word in the Entry window

@ECOED AP E]~

toxic ¥ = |acetylene

B toxic; adj..r|/o'setilizn/ = n.
B8 toxic shock {| Chemistry @Toxic
BB toxicant; n. hydrocarb&

2. Display dictionary entry B8 toxico-; cor|ywhich burns with

> Tap on the exact word or on a word that is closest to the =:g::‘gﬁe";§ya a bright flame,

one you are searching for in the List window toxin; n/1 |Used in welding
B bo tulinuma| 214 formerly in
B toxo-; coml lighting; ethyne.
& toxocarawn| [C=T2.]

B toxocariaws| - ORIGIN C10:
Y *__7|fromACETICACID +




5.3 Viewing Word Cross References

The cross-references available in some of the dictionary databases are enabled as
hyperlinks. DEPReader allows you to view cross-references by tapping on them.

1. View cross-references
» Tap on a cross-referenced word or compound found in
the definition of a term

DEPReader will immediately display the cross-referenced
word in the Entry window.

5.4 Viewing Bible Cross References

@ECOE

acetyle v &=
B acetylene; |
BEacetylide; n
B acetyl; n./1
B acetylsalicy
EAchaean; n.
B Achaemenid
B achalasia; n
& acharnermar
2 fidus Achade
BEache; n. v

B achene; v
L

D AP E]~
/a'setilizn/ ® n. T
Chemistry a toxie
hydrocarbon gas
which burns with
a bright flame,
used in welding
and formerly in
lighting; ethyne.
[C-H-.]

- ORIGIN C1g:

f ACETIC ACID
(] -¥YL 5 -ENE. -

mcm

D I>EFEI~

acetyle v =
BEacetylene; |
B acetylide; n
B acetyl; n./1
B acetylsalicy
EAchaean; n.|
B Achaemenid
B achalasia; n
B acharnemar
B2 fidus Achaie
B ache; n., v

B achene; nw

-yl = suffix
Chemistry forming
names of radicals:
phenyl

- oriciv from Gk
hul @ 'wood,
material’.

Some dictionaries of the Bible, such as 7he Easton’s Dictionary With You, KIV
Dictionary With You, The Oxford Dictionary of the Bible, etc., compatible with
GMPSoft’s applications may contain cross references to verses in the Bible.

If you install a Bible translation compatible with GMPSoft’s applications, DEPReader
will give you an immediate look-up of the cross references by visualizing the Bible

verses with pop-up window option.

1. Install a GMPSoft Bible translation
> Download Bible translations from
www.biblewithyou.com
> Follow the installation instructions for Palm OS:
http://www.biblewithyou.com/faq.php?id=install_soft

2. Activate the Bible translation in DEPReader
» Open the Select Books form (see how in section
3.1Selecting a dictionary)
» Tap on Scan
> Enable the desired Bible translation
» Tap on Done

Select Books

Dictionar
KJV
Easton

ies

Webster 1913
[ Concise Oxford English Dict
[ Packet Oxford English Dict

Oxford
Bible

Dictionary Of The Bi

@® New American Standard
O King James Version

[ Close] [ Scan ) [ Dane ] )




3. Vizualise Bible Cross References
Cross references to verses in the Bible are indicated by the
abbreviation of the Bible Book, chapter and verse in blue and
underlined font.

» Tap on the abbreviation of the Bible Book, chapter and
verse to open the pop-up window

4. Exit pop-up window
» Tap anywhere on the screen

5.5 Most Recently Used (MRU) Searches

The application saves a MRU list of the words and letters that
were entered in the Lookup field. A record of what is entered
in the Lookup Field is created each time you tap on a word in
the Word Listto display its dictionary entry.

1. Display the list of most recently entered searches
for words or letters
> Tap on the down arrow at the right of Lookup field

[DEPR EEe 40 FE~
Artoxer:xes InEzrad: 7 et the  §
reference is prabably 1o
Artazxeres |, king of Parzia
d65-424 BCE, whose appointment
of ¥Meherniah az governor in
Jerusalern was probably toassizt
hiz arnbitions aaainst ¥Eawot.

|
NETE W30 N P —

Artaxerced
Cart

e Artaxerxes
L Artarnis
b=

n,

A A

[DEPR L6l ZElv

John v «= | John,epistlesof 3
Three epistles

= John, epistle

2 John 1:3

3 Grace, mercy and peace hn
will be with us, from God
the Father and from Jesus
Christ, the Son of the
Father, in truth and love.

It

John

7| 1:3JehnD.Th

@ECOED qPEFE]~

innovati ¥ = [innovative
innovative /mavatry/ W adj.
featuring new
methods or
original ideas.

= creative in
thinking.

& nnuendo; n
Einnumerable
BEinnumeram,
Einnutritious;
Einoculum;i.
Hinoculate %




5.6 Error Tolerance Search

If you are uncertain of the correct spelling of a word or have not received a result
with the Standard Search and you suspect you may have mispelled it, you may try
Error Tolerance Search to receive suggestions for words whose spelling is close to
the word you have entered.

This search is helpful when you have (1) added extra
letter(s), (2) missed letter(s), (3) confused letter(s) or have
(4) transposed letter(s).

Examples:

(1) ‘refference — for an extra letter

(2) *narow’— for missing letter,

(3) ‘vizualize’— for confused letter(s)

(4) ‘downlaod’— for transposed letter(s)

1. Enter a word in the Lookup field
> Use the Silkscreen Graffiti area or the system keyboard

m < fde] ] IPEE
2. Perform an Error Tolerance search wander = v. walk or move in af
> Tap on the Green Search Tab leisurely or aimless way. = movel
slowly away from a fixed point
. . . . or place. » travel aimlessly
As a result, the reader will display a list of words in the through or over (an area). = n,
selected dictionary that may be obtained from the one you an aet or instance of wandering. ¢
entered by adding, removing or changing a letter, or by wonder v -
; & fonder (fond; adj./2)
transposing some of the letters. B ponder (ponder; v./1)
B wander (wander; v.,n./2) >
3. Display the dictionary entry of a word {Bwinder (winder-n/1) -

> Tap on a word in the search result

4. Exit Error Tolerance search
» Tap again on the Green Search Tab

5.7 Phonetic Search

The Phonetic Search feature allows you to search for words knowing only their
pronunciation.

1. Enter the_word as it has sounded to you in the (TR = coeo Do~
LOO/(U,D field carat /’karot/ ® n. 1 a unit of §
> Use the Silkscreen Graffiti area or the system keyboard weight for precious stones and |

pearls, equivalent to 200
. . , . . milligrams. 2 (US also karat) a
For example, if you have heard ‘karat’, enter this suggestion measure of the purity of gold, §
in the LOO/(U,D field. pure gold being 24 carats. i
karat -

2. Perform a phonetic search =T

> Tap on the Pink Search Tab Bcarrot; ""4,3 ;
V..

DEPReader will display a results list of the words that are or
may be pronounced like what you have heard. The words



are listed by how likely it is for them to be pronounced like
your search term — the top of the list shows the words that
have exactly the same or closest pronunciation.

3. Display the word entry

» Tap on a word in the search result

4. Exit phonetic search

» Tap again on the Pink Search Tab

5.8 Crossword Search

Suppose you are doing a crossword and you come to a clue you simply can't solve,
or a sequence of letters that looks like no word you know. Your only hints are the
length of the word and a few letters.

1.

Enter your word in the Lookup field
> Use the Silkscreen Graffiti area or the system keyboard

Substitute each missing character for a question mark (?)

Perform a crossword search
> Tap on the Blue Search Tab

The result will be a list of the words matching the criteria by
having the same length and the known letters in the
appointed positions.

Display the word dictionary entry
> Tap on a word in the search result

Exit crossword search
> Tap again on the Blue Search Tab

m B oD

angwantibo /ay'gwontibau/
= n. (pl. angwantibos) a small
rare nocturnal primate of west
central Africa, related to the
potto. [Aretocebus
cafabarensis ]

M=t

an?w??ti?? hd
B angwantibo (angwantibo; n./1)

‘
g
-
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6 Tables

DEPReader supports the tables provided by some dictionary databases. Tables may
contain one or more columns with entries on a certain topic. The names of the tables
are indicated by capital letters.

6.1

1.

Working with tables

Choose Tables... from the View menu

> See how in section....

> Tap on the Headline bar or the Menu button to display
the form menu

> Tap on View

> Tap on Tables...

> Draw the Graffiti Menu Command stroke » and the letter
L on the silkscreen

View Next or Previous Tables
> Tap on the forward or on the backward arrows in the
Headline bar

Some dictionary databases may contain more than one table.

Look up a term or compound from a table with

DEPReader:
> Tap on a term or compound in the table

DEPReader will perform a search for that term or compound.
The Smart Word List will be positioned on the items that
closely match your query.

For more on the Smart Word List, read Section 4 Smart Word
List.

(Book Edit I

Previous
T Next
Ehood| Bookmarks... 7K

Ehood|Add To Bookmarks 0
B'll; co

; Notes... 7N
B'n; ccf gy

BE're: : Edit Note P4
E's; co| Tables... 7L

B'tis; contra!
H'twas; corr
B'twere; cowml

B 'twixt; cowt

AFRICAN COUNTRIES A JRIF
Cauntry Mationality

Algeria Algerian

Angola Angolan

Benin Benineze

Batswana Botswanan

Burkina Fazo Burkinan

Burundi Burundian
Carneroan Carneraanian

Cape Verde Cape Verdean
Island=

Central African  Central African
Republic

VITAMINS J4Dé£
Letter Chemical Name

A (retinol )
B1 Tamine

B2 riboflavin

B3 niacin

B& pyridoxine

B12 cyanocobalamin

B complex folic acid, pantothenic
acid, biotin, inositol

C ascorbic acid

D2 calciferol

D3 cholecalciferal

mpom AbFE]~

retinol ¥ == |See VITAMINS

Eretinol; n./1
BEVITAMINS
Eretinue; n./
Bretire; v./5
BEretirement;
Bretiring; ad)
BEretook
Hretake; van
BEretort(1)a,
BEretort(2)wi,
Bretouch; W
A AT




4. Open a table from the Lookup field:

Some terms may be included in a dictionary database both
as dictionary entries and as table entries. Tables related to
the search term are listed in the search results when you
perform a search for such terms.

For example, the term *filbert’” (from POED) is both a
dictionary entry and is included in the table NUTS.

> Perform a search in DEPReader — see how in section 5
Searching for Terms

Entries in the Smart Word List denoted as cow (/ist) — show
that the entry is an item from a table.

Entries in the Smart Word List such as NUTS (denoted by
capitals) indicate a table.

In order to open a table:

> Tap on an entry in the Smart Word List that is denoted by
...(list)

Or

> Tap on the name of the table to open it

5. Returning to DEPReader

> Tap on the DEPReader icon, gf , at the right upper
corner of the screen

mPOED PFE~

cow v -
Bcow(1) n./3
BEcow(2) v./1

ND THEIR YOUNG
cow (list)
milch cow; n./1

B sacred cow; n./1

B sea cow; n./1

B mad cow disease; n./1
B coward; n./1

B cowardice; n./1

B cowboy: n./2

W, ,

L4 D

mPOED PFE~

filbert halh
Eﬂhm’ n./1

NUTS
Bilch, v iy

Efile(1) n.v./6

Efile(2) n.v./2
BETO0LS

Endian file; n./1

B nail file; n./1

BEsingle file; n./1

B filial; adj./1

& filibuster; n.,v./2

W, , -,

L4 D

AFRICAN COUNTRIES A RIS

Cauntry Mationality

Algeria Algerian
Angala Angalan

Benin Beninese
Batswana Botswanan
Burkina Fazo Burkinan
Burundi Burundian
Carneroan Carneraanian
Cape Verde Cape Verdean
Island=

Central African
Republic

Central African




7 History

Dictionary and Encyclopedia Personal Reader keeps a history of the dictionary
entries displayed, allowing you to move back and forward in the history list.

1.

Go to the previous entry displayed

> Tap on the Headline bar or the Menu button to display
the form menu

> Tap on View

> Tap on Previous

Or

» Tap on the BackArrowq icon in the Headline bar

Go to the next entry in History

» Tap on the Headline bar or the Menu button to
display the form menu

> Tap on View

> Tap on Next

Or

» Tap on the forward Arrow D icon in the Headline bar

((Book Edit TN

Previous

B caus Next
& cos(3|Bookmarks... 7K
&'d; c«c|Add To Bookmarks /0O

&'gain: Notes.. <N

BEhoodl| -
B hoodi Edit Note 71

B hood(| Tables... <L
&'ll; contr./!
E'm(1) abk-¢
E'm(2) n/¥
E'n'; contrwi
A AT

mucom =i

flute = n. 1 a high-pitched i
wind instrument consisting of a
tube with holes along it, usually
held horizontally so that the
breath can be directed against a
fixed edge. 2 Architecture an

4

LD T

flute

& flute; n.,v./5

& fipple flute; n./1
Enose flute; n./1

P_Lr_ansverse flute: n./1
, -,




8 User Notes

Dictionary and Encyclopedia Personal Reader allows you to add your personal
notes to dictionary entries you have checked in one or in all of the dictionaries that
are installed.

You may have notes to entries in one of the dictionaries
installed as well as notes to entries in different dictionaries.
If a word exists in a number of the dictionaries installed, you
can have separate notes to the same word for the entries
found in the different dictionaries.

8.1 Attach a Note

1. Selectaword WTTTRTTY View |
> See how in section 5.1 Standard Search. Previous
B caus Next
& cos(3| Bookmarks... 7K
2. Attach a Note 'cdo,'s_cc H:: Tnl:aBro:kmarks <0
> Tap on the Headline bar or the Menu button to display gr?:o";' Notes.. /N
the form menu Bhood(| ENIt Note 7!
> Tap on View Hhood(Tables.. 7L
B &'ll; contr./!
> Tap on Edit Note B'm(1) abk-q
Or I:rq(z) n./:
> Draw the Graffiti Menu Command stroke » and the letter | oot

I on the silkscreen
» Tap on the Add Note (E?') icon in the Headline bar

A Note will be attached to the word’s definition provided by
the particular dictionary only.

3. Enter your text :
> Use the Graffiti Silkscreen area or the System Keyboard %

Unfiled

4. Change the Note category

> Tap on a Notes category displayed at the right upper
corner of the screen
Tap on the desired category in the list

-

Click on the Details button

Tap on the down arrow displayed after Category (Done) (Detais)
Select a category from the list (Dane ) (Detale)

VVVYYVOY

Tap on OK

5. Exit Note
» Tap on Done



8.2 Edit a Note
You may edit a note, if one exists for an entry in a particular dictionary.

1. Edit Note for a dictionary entry

> Select a dictionary entr

> Tap on the Add Note ([?') or Edit an Existing Note (E?')
icon in the Headline bar

Open Notes window

> Tap on the Headline bar or the Menu button to display
the form menu

> Tap on View

» Tap on Notes...

Or

> Draw the Graffiti Menu Command stroke » and the letter
N on the silkscreen

Open a Note
> Tap on a Note in the list

Edit a Mote
> Edit the text of the note

8.3 Manage Notes Categories

1.

Open Notes window

> Tap on the Headline bar or the Menu button to display
the form menu

> Tap on View

» Tap on Notes...

Or

> Draw the Graffiti Menu Command stroke » and the letter
N on the silkscreen

Open Edit categories window

> Tap on All in the right upper corner to display the
categories list

> Tap on Edit Categories...

. Create new Notes category

» Tap on New
> Enter the new category name
> Tap on OK

mﬂcom -

flute = n. 1 a high-pitched i
wind instrument consisting of a
tube with holes along it, usually
held horizontally so that the
breath can be directed against a
fixed edge. 2 Architecture an

w
flute -
B flute; n.,v./5 A
& fipple flute; n./1 -~
B nose flute; n./1 ¥
P_Lr_aus_\grse flute: n./1 v

h, . £
oo ~a

1. marker; n./5 (COED)
2. commercial; adj.,n./5 (COED)
3. angwantibo; n./1 (COED)

Business
Personal

Unfiled

Edit Categories...

1. marker; n./5 (Ci
2. commercial; adj
3. angwantibo; n./

Edit Categories... o

Business

Personal

(New ) (Rename ) [ Delete )




4,

5.

Rename Notes category

Tap on a Notes category in the list
Tap on Rename

Enter the new name

Tap on OK

YV VY

Delete a Notes category
> Tap on a Notes category in the list
> Tap on Delete

9 Bookmarks

Dictionary and Encyclopedia Personal Reader allows you to Bookmark specific
words and store Bookmarks in different categories.

9.1

6.

9.2

You may bookmark entries in one of the dictionaries installed
as well as bookmarks to entries provided by the different
dictionaries installed.

If a word definition exists in a number or all of the
dictionaries installed, then each — e.g. you can add separate
bookmarks to the same word for the entries provided by the
different dictionaries.

Bookmark a word

Select and display a dictionary entry
> See how in section....

Choose Add to Bookmarks from the View menu:

> Tap on the Headline bar or the Menu button to display
the form menu

> Tap on View

> Tap on Add to Bookmarks

Or

> Draw the Graffiti Menu Command stroke » and the letter
o

A Bookmark will be added to the word’s definition provided by

the particular dictionary only.

Manage bookmarks

1. Choose Bookmarks from the View menu:

> Tap on the Headline bar or the Menu button to display
the form menu

> Tap on View

> Tap on Bookmarks

Or

> Draw the Graffiti Menu Command stroke » and the letter
K

Note: You need to have at least one bookmark in order to

open the Bookmarks form.

| Book

Edit T

B'caus

Previous
Next

B cos(3
BE'd; cc

Bookmarks...
Add To Bookmarks

7K
70

& 'gain:
Ehoodi

Notes..
Edit Note

<N
71

Ehoodi
Ehoodi

Tables...

<L

B'll; contr./?

&E'm(1)
BE'm(2)

abk g
n/¥

E'n'; contrwi
O

| Book

Edit T

B'caus

Previous
Next

B cos(3
BE'd; cc

Bookmarks...
Add To Bookmarks

7K
70

& 'gain:
Ehoodi
Ehoodi

Notes..
Edit Note

<N
71

Ehoodi

Tables...

L

E'll; contr./!

&E'm(1)
BE'm(2)

abk g
n/¥

E'n'; contrwi
O




2. Select a bookmark
» Taponitin the list

3. Edit a bookmark — you can change the name of the

bookmark and the category it belongs
> Tap on Edit

3.1. Rename the bookmark
By default, Bookmarks are named by the respective word.
>  Enter the new name

Current: W General

iaenaral - Al
Edit Categories...

(Back) [GeTo [ Edi )(Delete]

3.2. Change a bookmark’s category — you can choose the bookmark’s category from

the list of current categories or create a new category.
> Tap on the triangle button against Current category
> Tap on a category in the drop down list

4. View a bookmark
» Tapon GoTo
Or
» Tap on it again

Warning: Because a Bookmark is being added to an entry in
particular dictionary, Go To will work only if that dictionary is
active.

5. Delete a bookmark
> Tap on Delete

6. Exit Bookmarks screen
> Tap on Back

9.3 Manage Bookmark Categories

1. Choose Bookmarks from the View menu:

> Tap on the Headline bar or the Menu button to display
the form menu

> Tap on View

> Tap on Bookmarks

Or

> Draw the Graffiti Menu Command stroke » and the letter
K

Note: You need to have at least one bookmark in order to
open the Bookmarks form.

Current: = Genaral

edal nc|Genaral - All

Fahrenh|Edit Categories...
farad; n.f1LLUEL)
microfarad; n./1 (COED)

(Back) (GoTo ) Edit )(Delete)

Current: = General

edal nc|Ganeral - All

Fahrenh|Edit Categories...
farad; n./f1LUED)
microfarad; n./1 (COED)

(Back) ((GoTe )(_Edit )(Delete)




Create a new category

Tap on the drop down arrow next to Current field
Tap on Edit Categories... from the Category list
Tap on New

Enter the category name

Tap on OK

YVVVVYVYYVY

Rename a category

Tap on a category in the list
Tap on Rename

Enter the new name

Tap on OK

YVVVY

Delete a category
> Tap on a category in the list
> Tap on Delete

Exit Edit categories screen
> Tap on Back

Edit Cateqgories... ﬂ

Business
Perzonal

Edit Categories

Enter a new category nanme:
10 Cretober




10Contact and support

Technical Support

In order to report problems or ask questions with regard to the software, contact our
Technical Support Department:

E-mail: support@gmpsoft.com

Sales

In order to obtain general information or product and sales related information,
contact our Sales Department:

E-mail: sales@gmpsoft.com

Partnership and Business Development

In order to enquire about partnering and B2B development, contact our Management
Department:

E-mail: ceo@gmpsoft.com

For detailed information on GMPSoft’s products, the registration, or for technical
support, check our web site: www.gmpsoft.com
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Dictionary and Encyclopedia Personal Reader (DEPReader)
This product and the algorithms used are property of GMPSoft. All rights reserved
2004-2005.



